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What’s Happening at OPEN 
Next Monthly Meeting  

August 2 at 1.00 pm 

FROM THE ASSISTANT 
EDITOR 
 

At the last Tutors’ Meeting on July 5 it 
was decided that a second E-Learn 
course would not be held this year. 
The decision was due to the low number  of potential  
enrolments and the realisation that trying to complete 
the course in just 3 or 4  months may place  pressure on 
both members and tutors.  
 

However I would encourage those members who want 
to participate in next year’s E-Learn course to familiarise 
themselves with the course material and keep studying. 
The 2007 course will almost certainly include word-
processing and spreadsheets, so any expertise gained in 
these areas will be of benefit.  
 

The late class that had been run on Thursday afternoons 
has been postponed for the time being as we have been 
able to integrate those attending into other sessions. 
 

Finally I would point out to members that some computers 
are still not being shut down correctly. The general rule is to 
leave the monitor switched on until the ’box’ shuts down 
automatically or an “OK to turn off” message appears. Be 
aware that at times the computer may have been set to the 
‘Restart’ option  - and that’s just what it will do unless you 
re-set it to ‘Shut Down’. 
 

    Dennis Murray 
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FAMILY HISTORY ON-LINE 
 

Standard sessions will be conducted on 
 

August 9 - 1 pm to 3.30 pm 
 

August 23  -  9 am to 12  noon 
 

 
 

1841 CENSUS INFORMATION 
 

We have been advised by ‘Ancestry’ that the 
1841 Census Information is now available 
for Scotland as well as  England, Wales and 
the Channel Islands as noted last month.  
 
Contact Judy Hall for more details  

OPEN COMPUTING MEETING 
Wednesday, August 2 at 1 pm 

 

Do you have any ideas for improving or varying OPEN’s 
operations?  
 

Is there a new class or activity you’d like to try?  
Why not come along to the next OPEN meeting and let 
us know. 
 

Our monthly meetings are not just for committee 

 members – any member of OPEN is welcome to come 
and participate or just find out what goes on ’behind the 
scenes’ at the club.  There are always ‘vacancies’ for 
people to act in support roles for our designated 
office-bearers. 

The OPEN Newsletter is part of the 
 Launceston Computer Group’s publication 
“Newstream”. 
 

“Newstream” is distributed by E-mail each 
month, or alternatively  can be viewed or 
downloaded as a PDF file from the LCG  
Web-site. 
 

GRAPHICS FOR BEGINNERS 
 

Wednesday August 9,  9 am–12 noon 
 

A class for new members to learn the 
basics of graphics and photo  
enhancement. 

 

QUESTIONS AND 
   ANSWERS 
Wednesday Aug 16  9 am–12 noon 
 

The number of members attending the 
Q&A sessions are increasing  so it  
appears that people are benefiting from 
the information provided. Come along 
and ask your questions and perhaps you 
will also learn something from the que-
ries that other people raise. 

 “EMBROIDERY GROUP” 
 

The Embroidery Group will be meeting on two  
Fridays this month - August 11 and August 25. 
 

For any details in regard to this class contact  
Eleanor Horder via OPEN Computing. 
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Launceston Computer 
Group 

SOFTWARE LIBRARY 
Dated 1st August 2006 

 
DISK 2000 - Your Library on Disk 
Disk 2000 is now available. The change from a floppy disk to 

a CD has enabled us to include much more in the way of 
games, information and utilities. Existing members can up-

grade to the new CD 
version for just $1.50 . Ask at the club or contact Judy via the 
e-mail address shown below. This disk is free of charge to all 

new members.  
 

DISK COPY PRICES - CLUB MEMBERS $1.00 per disk 
Disk Prices - Box of 25 =  $12.00 Members Only 
CD Prices – Box of 10  = $10.00  Members Only 
 
Games CDs #2 and #3 are also available featuring  
games that are suited to Windows 98 and later. 
 

AVAILABILITY OF LIBRARY 
 

The Shareware Library is available in be-
tween meetings from the following per-
son. Please telephone first to arrange a 

suitable time.  
 

The library is also available at the venue - 
Studioworks most Wednesdays 9am to 3pm. Email:  
opencomputingtas@hotmail.com 

Launceston Computer Group 
Monthly  

 Workshop 
Wednesday August 2  

 
 
 

E-Bay – Judy Hall will conduct this   
session on how to access and use the 
popular on-line auction site. Learn 
how to set up your own account and 
other basics. 

OPEN NEWSLETTER – AUGUST 2006 

NORTHERN TASMANIAN 
CAMERA CLUB WORKSHOP 

 

This month’s column starts with a clarification that 
the monthly get-togethers are Workshop 
sessions in which participants use the popular Paint 
Shop Pro program to learn photo 
enhancement techniques.  
 

Saturday August 12 is the date for the next 
workshop and Kai Johnson will be there to pass on   
her skills and experience. 
 

If you are interested in learning more about digital 
cameras and related subjects contact Kai on  
6326 2358. 

NEXT TUTORS MEETING  
 

Will be held on Wednesday September 6 at 10 
a.m.  
 

For the time being Tutors’ Meetings will only be held 
every two months so please take these opportunities to 
contribute your suggestions on matters affecting how 
we provide tuition to members. 

VENUE TELEPHONE NUMBER 
 

 

Members can be contacted at the clubrooms  
during class hours  by telephoning the number 
shown below. 
Monday to Thursday  10am – 3pm 
Friday   10am  - noon 

0413 698 610 

EXTRA CLASSES  
WEDNESDAY AUGUST 30 

 

Morning session 9 am to noon 
CD-burning  and DVD-burning  

 

Learn how to record your documents, photos and  

movies on to CDs or DVDs for safe-keeping or sending to 
family and friends. 

 

Afternoon Session 1 pm to 3.30 pm 
Introduction to Microsoft PowerPoint 

 

Learn the basics of  Microsoft’s presentation tool and 
create a basic slideshow incorporating photos, text, 
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Monday 10 am –12  E-Learn &  
Beginners 

 1 pm – 3 pm Basics and Beyond 

Tuesday 10 am –12  E-Learn &  
Beginners [all day] 

 1 pm – 3 pm  Mac [all day] 

Wednesday  Special sessions or Meet-
ings 

  As for mornings  
(see rosters) 

Thursday 10 am –12  
 

E-Learn & 
Beginners  

 1 pm – 3 pm E-Learn & 
Beginners  

Friday 10 am –12  E-Learn &  
Beginners 

2nd, 4th  
Fridays 

1 pm – 3 pm Embroidery Group 

2nd or 3rd 
Saturday 

10 am –12  Camera Club 

OPEN Session Times 
At Studioworks, 1 Pipeworks Rd, L’ton 

 
Standard Sessions $4.00 
[Some special tutorial materials may incur 
additional charges] 

SPECIAL  WEDNESDAY SESSIONS 
Please register on the sheets – numbers may be limited  

Date Time Topic Details 

August 2 10 am – 12  ‘Working Bee’ Help compile induction packs, stationery etc. 

 1 pm onwards  OPEN General Meeting General discussion on matters affecting OPEN.  

 7.15 pm  
onwards 

Launceston Computer 
Group Meeting 

Club President Judy Hall will provide  an intro 
to the on-line auction site e-Bay 

August 9 9 am – 12 noon Basic Graphics  A session for beginners to learn the basic skills in 
graphics manipulation. 

 1 pm – 3.30 Family History On-line The 1841 Census information for Scotland is now 
available. 

August 16 9 am – 12 noon Questions and Answers A general forum on any computer topic that may be 
puzzling you.   

August 23 9 am – 12 noon  Family History On-line Research your family history using the Internet and 
other resources provided by OPEN. 

 1 pm – 3.30  Microsoft Access TUTORS ONLY 

August 30 9 am – 12 noon CD and DVD Burning 

Workshop 

Learn the skills required to copy all types of files to 
CD and DVDs  

 1 pm – 3.30 Advanced Graphics  
Paint Shop Pro 7 

Continuation of the Advanced level classes.  

 1 pm – 3.30 Introduction to MS  
PowerPoint 

Create a basic slideshow using Microsoft’s  

presentation program. 

OPEN NEWSLETTER – AUGUST 2006 
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WHERE OH WHERE HAS MY LITTLE ‘DOC’ GONE? 
 

Can’t find a file that you saved a few minutes ago? Use the 
Start Menu>Documents or Recent Documents to see a list of 
recently used files. Or re-open Word and check the entries at 
the bottom of the File Menu. 

“VICTOR” (continued) 
 

Windows Service Pack 2 

For people with older versions of Windows 
XP you may find at some time, that you 
will get a ‘blue star’ that will appear in the 
system tray saying that you will be unable 
to receive updates from Microsoft until 
Service Pack 2 has been installed. If this 
happens to you please contact the VICTOR 
program and we will be able to 
install Service Pack 2 for you. 
Dial-up Security: 
With the advent of broadband modems these have the 
protection of a firewall that allows safety when surfing the 
Internet, Unfortunately dial-up does not have that facility. 
Windows XP has its own in-built firewall which can be 
activated but it’s not enough to stop someone trying to 
infiltrate a computer. The best free program around to 
protect you while you are on the Internet is Zone Alarm 
free edition.  

There is one drawback to the program (if you consider it a 
drawback) and that is every time you add a new program 
or update a program it will ask you to either allow or deny 
the said action. It takes a little time to get used to that but 
it will protect your computer from hacker attacks. There is 
a paid version and that allows you to see what country the 
hijack attempt has originated from. For the average 
computer user it’s not an essential. If anyone has any 
questions that “the vault” may have an answer to please 
contact me and we can answer your question or we can 
ask other readers to write the answers and publish them in 
our newsletter. Till next month, Happy Computing.  Rob 

 

Contact VICTOR’s Co-ordinator Rob  
Tierney on 0417 555 398 for details. 

TALES FROM THE VICTOR VAULT 
 

This month is a Potpourri of little tidbits and  
information that maybe of interest to you. We will be 
touching on the following: What is a mouse  
potato? Do you google, are you into googleing . 
Windows XP Service Pack 2. Dial up internet se-
curity. 
 

Recently a heap of new words have worked their way 
into our everyday language to such words are mouse 
potato and google. Here are the definitions firstly: 

mouse potato: 
A human being who spends an  

inordinate amount or time 
"pointing and clicking" using a 
mouse device with a computer 
and/or staring at a computer 

screen. 
Google: trademark for a search 

engine to use the Internet to 
obtain information about various 
topics on the World Wide Web. 
Other forms are Googled and 

Googleing. 
 
 

N.B  when I typed in the definition “to google” I found 
something interesting. The word google is not new for 

movie buffs – here is its origin. 
 

The word "google" was first used in the 1927 Little 
Rascals silent film "Dog Heaven", used to refer to a 

having a drink of water. 

“ORGANISE YOUR DESKTOP” 
 

The ability to start programs by double-clicking a desktop  icon 
(or single-clicking  and pressing ENTER) is a vast improvement 
from my early experiences of computing when most 
commands had to be typed in at the DOS-prompt (>) or 
selected from a menu. But that advantage can be  lost if you 
have to hunt through a maze of icons to find the program you 
want to run.  
 

Due to the variety of classes that we conduct at OPEN  there 
are many more desktop icons on our computers than most 
people would encounter at home, so there is more potential 
for confusion. Let’s think about ways we can organise our 
desk-tops more efficiently. 
 

Sub-divide the icons into logical groups e.g. put all the Office 
programs together in the middle of the screen and the 
Graphics programs at the right. Use the top left-hand side of 
the screen for the ‘un-delete-able’ system icons and the 
bottom left for frequently used system programs – My 
Computer, My Documents etc.  
 

Some programs that you install create icons that you’ll rarely 
use e.g. WinZip and Adobe Reader, which each automatically 
start when you double-click ZIP and PDF files. Get rid of them 
or place them in a Not Used Often desktop folder. The 
software accompanying Scanners, Printers and Digital Cameras 
can  be notorious for creating 4 or 5 desktop icons each – you 
don‘t need them 24 hours each day, 7 days each week, so put 
them into folders where they can be accessed  when required. 

 

Finally, try not to save documents or downloads to the 
desktop, or at worst, delete them after you finished using 

OPEN NEWSLETTER – AUGUST 2006 
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Composition 3 
Brian Plush 
This month is less about composition and more about the most vital 
tool to achieve good composition:    the viewfinder. 
However not all viewfinders are equal. Ever taken a photo and 
thought ‘What’s Aunty Maud’s knee doing there!’ 
Well, you probably didn’t know that many cameras’ viewfinders do 
not display 100% of the image. It ranges from about 85% to 95%. 
Only the pro cameras show 100%, which is one reason why they 
cost a little more. Professionals always want to know exactly what 
they are shooting, not a millimetre more, not a millimetre less! 
So it’s quite possible your viewfinder maybe a little out. 
Now by viewfinder, in this article I also include LCD viewing 
screens as opposed to the tiny little window one pokes in one’s eye. 

What is in your viewfinder? 
Viewfinders are deceptive little suckers! Stand in the photography 
line at the local chemist and you frequently hear indignant voices 
declaring, ‘But it all looks so small!’ 
It seems that many of the snap shooting fraternity don’t relate what 
they see in their viewfinder to what’s in front of them when they lift 
their eyes away from the camera. 
The scene may look wonderful, but if it looks small and rather 
under-whelming in the viewfinder that’s exactly how the final image 
will turn out. The human eye selects the important elements of 
any scene and sees the good bits. Cameras can’t. They see 
everything equally. There’s no ‘abracadabra’ inside the camera 
saying, ‘Let’s zoom in.’ 

Learn to use your viewfinder 
Look at it carefully. Look around the centre of interest. Imagine the 
viewfinder as if it’s a picture, flat on your wall. Now do you really 
want that image? 

See what happens when you move position. Is that better?  
Carefully check all corners of your viewfinder, particularly the 
background. Things lurk in backgrounds just waiting to appear 
as protrusions out of heads, distractions, little things which 
fight for 
attention. 
Hot spots are the small bright things that catch the eye, a piece 
of paper, rubbish on the ground, a leaf glinting in the sun, a 
brightly coloured stone. 
Hot spots are to be avoided and often it’s as simple as moving 
slightly, or heaven forbid, picking that something up (and 
chucking it in a bin!). 
Make sure you don’t cut things off with the edge of your 
viewfinder. Aunty Maud’s elbow doesn’t look right snipped off 
and she probably won’t appreciate it either. 
Even out of focus some objects just don’t work. For example, 
galvanised iron fences always remain galvanised iron fences 
despite how much they blur and despite how wonderful the 
close-ups of the roses are. Hang a coloured sheet behind the 
roses far enough back to blur. That will solve that problem, or 
you could dig the roses up and shift them! 
Remember what’s in your viewfinder now, will be there in the 
final image. 
Trees don’t grow out of heads sometime between the shutter 
being released and previewing the image on the computer. 
Chemists don’t keep a pile of blurry distractions to sprinkle 
over your prints before 
handing them back for $6.90. 
So remember, with your viewfinder you compose the image by 
looking at what is really there. 
With your viewfinder you search out hot spots to fix, severed 

(Continued on page 8) 
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limbs to put back. 
And finally if it doesn’t look quite right through your 
viewfinder, change your position. 
The whole beauty of a digital camera is you have instant 
preview of your image. Film photographers have to wait a 
week, a month, or until next Christmas before they can see 
what they shot! You digital people are so much luckier! 

LCD panels 
on two digital 
cameras. 
That on the 
Nikon is 
larger, but 
there is no 

optical finder. The Canon does have an optical viewfinder, and its 
LCD pivots, and can be viewed from many angles, even from in front 
From AppleSauce August 20065 

 

(Continued from page 7) Review: Digital Audio Essentials 
George Carrington 

I first got seriously interested in transcribing audio about 35 years 
ago, when we were living in Port Moresby. If you liked listening to 
music, you had the choice of the local radio station or playing your 
own records. As the local radio would deliver about two hours of 
“decent” music a week, we used to play our own records. The trouble 
with records though is that the more you play them the more they 
sound like it. Our solution? We would transcribe the records to 
cassette tapes, and play these to death instead. 

Fast forward thirty+ years. Living in Canberra there is no dearth of 
“decent” music on the radio, and if that isn’t enough, I can always tune 
in to Internet Radio in my iTunes, yet somehow I still prefer my 
records. Trouble is they won’t fit into the slot on the side of my iMac, 
and, as we learnt when we changed from 5.25” to 3.5” floppies, 
folding the 5.25” ones in half didn’t work, the only solution was to 
transcribe my records – in my case to CDs. 

Now, there are two ways of learning how to do that. You can 
follow my footsteps and learn the hard way, or you can pick up a book 
like Digital Audio Essentials – A Comprehensive Guide to Creating, 
Recording, Editing, and Sharing Music and Other Audio (Bruce & 
Marty Fries, O’Reilly, 360pp, ISBN 0-596-00856-2, $65 at Dymocks). 
I would strongly recommend the second course as being, in the long 
run, less painful and less expensive. 

Digital Audio Essentials is a typical O’Reilly paperback. It starts 
out with one of the briefest Introductions I have yet encountered in all 
the O’Reilly books I’ve ever read – the authors waste no time in 
getting you started. Part I: Going Digital gives you a brief introduction 
to digital audio, and then promptly, with The Right System for the Job, 
gets you going on setting up your audio/computer combo. I think that, 
for us, I can summarise this chapter by saying that if you have a recent 
Mac, adequate RAM and a stereo player less than twenty years old, 

(Continued on page 9) 
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you’re set. To transfer the audio to your computer you need to 
Connect Your Computer to Your Stereo. Unlike the previous chapter, 
this one you’d better read. Mind you, I’m surprised that the Griffin 
iMic doesn’t get a mention here – IMHO it’s still one of the easiest 
ways of hooking up your Mac and your stereo.  

Frankly, if all you’d want to do is to transcribe your LPs to CDs, 
and aren’t too fussy about the result, you could stop here – and miss 
out on a lot of other useful information.  

Part II: Listening to Digital Music starts off with Organizing and 
Playing Music, which makes me glad I’m on a Mac, though I have to 
admit that I was startled the first time I saw an illustration of iTunes 
under Windows. Actually, this chapter provides as good an 
introduction to iTunes as you’d find anywhere. The two chapters that 
fascinated me were Music on the Web (I think I now have a glimpse 
of what my daughter is talking about!) and Listening to Internet 
Radio. Reading the latter I was tempted – once again – into trying the 
iTunes Radio “playlist” entry. As I hadn’t tried it for some time, I was 
pleasantly surprised at the range of music you can get this way, and 
the authors show you a few more avenues worth exploring. I’m sorry, 
but Music on the Move left me cold. I don’t own an iPod nor even a 
Walkman, and I suspect that the radio in my car is rusty from disuse. 
However, if you’re considering getting an iPod for yourself or even 
for someone else, this chapter has some interesting stuff. 

With Part III: The Nuts and Bolts of Digital Audio we get into the 
more serious stuff. I appreciate that much of this is fairly technical, 
but the authors have made it remarkably accessible even if you’re a 
confirmed technophobe. I would suggest that you should read both 
Understanding Digital Audio and Digital Audio Formats. These two 
chapters lay down the groundwork for Part IV: Capturing and Editing 
Audio. Unlike the rest of the book, where you can cheerfully dip in to 
read what you might consider interesting, and either skim (as I have 
done) or even completely ignore large chunks,  

Part IV you must read – even if for no other reason than to make 

(Continued from page 8) you feel glad you’re using a Mac. For me this was the part of the book 
that made having the book in front of me worthwhile – I can now see 
where I’ve gone wrong, but I can also see how to do better in future. 

Part V: Sharing and Distributing Your Music sort-of rounds out 
the book. I found Burning Your Own CDs and DVDs very useful and 
full of practical tips. Even though Digital Audio and Copyright Laws 
is primarily aimed at an American audience, I believe everyone 
should read it, and take the underlying message to heart. And finally 
there’s the Index. I think it’s adequate, even though my copy of the 
book ended up with tags sticking out all over so that I could again find 
those bits I wanted to go over in more detail.  

In the Introduction the authors suggest that this book is suitable 
for audiophiles with a wide range of technical expertise. I agree – I 
consider myself a reasonably tech-savvy amateur, yet I still learned 
quite a few bits from this book, without finding it too “technical”. On 
the other hand I feel that this book is wasted simply sitting here on my 
shelves, which is why I’m sending it up to my daughter to take it to 
her school and put it into their library. Have you considered doing 
something similar? 

F r o m AppleACT June 
2006 
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Tutorial "Remove That Unwanted Stuff From Your PC" 
 Joe Robson 
http://joerobson.com 
===================================== 
We've all been there haven't we? 
Trying to remove unwanted items from your computer can range from the trivial, 
to the downright nerve-wracking. 
First let us classify the various types of 'unwanted items' in existence. Also for 
the purposes of this article, assume that a Windows-based computer is the 
object of this exercise. 
Unwanted items in the most generic sense may appear in the form of files 
(items of data), or programs (executables), either fully installed in the normal 
fashion (using the Windows Installer program), or simply stored in some folder 
location. The latter simply needs to be clicked on for it to run as intended, or 
unintentionally triggered by some other process. Moreover, programs may be 
'hostile'. In other words they may be malware - a virus, trojan, spyware or 
Adware. 
Below are listed some of the more common types of unwanted items that may 
be found on your computer. 
Unwanted Data:  
Removal of unwanted data can be simply by identifying, locating and deleting 
the data file, followed by emptying the trash can. 
However, you should be aware that if security is an issue, simple file deletion as 
described above will not completely remove all traces of the data. To ensure 
that sensitive data is removed 'forever' the data must be overwritten with new 
data designed according to recognized secure methods. Details of such a 
procedure are beyond the scope of this article. 
Since it is theoretically possible to retrieve even data that has been overwritten, 
some would argue that the only secure way to prevent sensitive data from ever 
being retrieved is to physically destroy the hard disk originally used to store the 
data. It is safe to say, though, that such retrieval would be way beyond the 
capabilities of all but the most technically sophisticated.  
Cache Files: 
 Cache files are used by Windows to help speed up the execution of routing 
and/or repetitive operations. While these are not 'unwanted' in the strictest 
sense of the term, over time the cache file size may grow unnecessarily large, 
thereby degrading computer performance. 
Internet Temporary Files:  

During the course of the normal use of Internet Explorer of other Internet 
browser, many temporary files are created. 
Windows Temporary Files:  
Windows creates temp files during software installation as well as various other 
operations. These files provide the ability to easily recover from various possible 
'glitches' that may occur during execution of a given process. 
Similar to Cache files, Windows uses 'temp' (temporary) files to provide 
smoother operation of various installed programs. Temp files are conspicuous 
by their '.tmp' file extension. For example, you will find temp files being created 
whenever programs such as MSWord or Excel are used. 
Unwanted Installed Programs:  
Any program originally installed using the Windows installer may be uninstalled 
by the usual (recommended) method of going to the Control Panel and running 
the 'Add/Remove Programs' utility. Many programs are also supplied with their 
own uninstaller. In such cases this feature should be used as a first option for 
its removal from your computer. 
It should be noted that if the program's own uninstaller and/or Windows 
Add/Remove Program utility fail to remove the program, other more intrusive 
means of removal may be employed. This option will be covered in Part II of this 
article. 
Malware:  
The removal of malware (spyware, adware, etc.) is typically the most challenging 
of all the procedures described thus far. In fact, the initial obstacle is 
recognizing that such an 'infestation' does indeed exist. 
Some of the first signs of possible malware infestation are: - Erratic computer 
operation. - Computer crashes. - Slower-than-normal operation. - Pop-up 
messages warning of virus infestation or other problem (trying to scare you into 
taking some particular action, such as visiting a website promising to fix the 
problem). - Your Home Page suddenly being changed from the normal site 
(home-page hijacking). 
To be sure, there are other factors that may slow down your computer or cause 
erratic behaviour, such as file corruption, or software bugs. However, there are a 
few procedures you can follow which will reduce or eliminate the possibility that 
your computer is in fact the victim of a malware 'attack'. 
It makes good sense to run a complete check for malware and remove any 
items found, and then perform routine maintenance procedures (temp file 
removal, etc.). 
The basic recommended procedures for removal of unwanted items from your 
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Geek Speak Busters  
=============================== 
------- GHz - Gigahertz 
A unit used to measure the frequency of electric vibrations per second. 1 GHz is 
equal to 100 Megahertz and 1 Billion hertz per second. 
Man that's a lot of vibrations:-) 
------- Memory - RAM 
Random Access Memory is the amount of memory available to a program at any 
time. Generally the more Megabytes (MB) of RAM your PC has installed, the 
faster and more efficient it will run. 
------- Storage Gigabytes (GB) 
This determines the amount of information and number of applications 
(programs) you can store on your PC. The higher the GB the better, as video and 
digital photos become more and more popular. 
------- Pentium 
A series of Intel (the manufacturer) processors for specific use in Notebooks. 
They are much lighter than usual and consume less battery power. 
------- Dual Layer 
The latest DVD optical drives, using compatible media, can read and write al-
most twice as much data to a single disk - up to 8.5 GB. 
------- LCD 
Full name is Liquid Crystal Display and employs technology using 3 liquid crys-
tals and a series of mirrors and lenses to project an image onto a screen such 
as a computer monitor or TV set. 
------- ANSI Lumens 
This is a measure of how bright a screen projector is. For business presentations 
look for 1200 or higher. 
------- DLP 
Digital Light Processing. This is a technology that replaces LCDs with a silicon 
chip. 
------- FSB 
Front Side Bus (where DO they get these names from?). It refers to how fast the 
main connection to the processor runs. The faster the better - of course! 
------- Processor. 
Like the engine of a car., a computer's processor dictates how fast a CC can run 
and therefore how fast it can perform tasks. 

 Back up and restore your emails 
Whether you use Outlook Express or Thunderbird, we explain how  to protect 
your electronic correspondence.    
Emails bounce back and forth all over the world between millions of people, yet 
how many take steps to back up and  protect that information? Think about 
what’s contained within  your emails.  
You might have personal correspondence that’s irreplaceable, Web site log-ins, 
business letters and more. Do you really want to risk losing all of that?   
It only takes one crash, hardware breakdown or virus to  destroy your data. So 
this month we’re showing you how to back up and restore two of the most 
popular email applications, Thunderbird and Outlook Express.  
A healthy Outlook  
We’ll take a look at Outlook Express first. Read the ‘Back up  Outlook Express 
emails’ step-by-step guide to find out one way  to back up email files. If you have 
multiple identities for Outlook Express (you may have one for each member of 
your family, for example), you’ll have to repeat these steps.  
Once you’ve saved the emails, you may also want to back up  your Address 
Book, Mail Account or Newsgroup account. To export your Address Book, go to 
the File menu and click Export > Address Book.  
Click Text File (Comma Separated Values), then  Export. Browse to your back-up 
folder and type in a name for your Address Book back-up file.  
Click Save > Next, select the  fields you’d like to export, then click Finish.  
To export your mail and newsgroups accounts, click Accounts or Tools on the 
Tools menu, depending on which you’re exporting 
Then on the Mail or News tab click the account you want to  export and then 
click Export.  
Choose where you’d prefer to  save to and name the file, then close. You can 
repeat these  steps for as many accounts as you have.  
Another way to back up  Outlook Express information is to use XP’s File and 
Transfer  Settings wizard. Read the step-by-step guide above to find out more. 
Restoration  
Restoring your Outlook Express information is as easy as saving it, however if 
you had several identities, you may have  to recreate them. To import 
messages, go to the File menu and  click Import > Messages. Then select 
Microsoft Outlook Express 5 or 6 from the list and click Next.  
Choose to import mail from a store directory and click OK.  

(Continued on page 12) 
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Tutorial ... "Complex Tasks The Easy Way" 
We're a mouse-crazed world. Before the invention of the mouse, everything on a 
computer was done using the keyboard. Today, you can still do TONS and TONS 
of stuff with the keyboard that you can never accomplish with your mouse. You 
just have to know how. 
Excluding the little round buttons added to a keyboard to increase its 'one-touch' 
ability, most boards have around 105 keys. From an ESC key on the top left to an 
Enter key on the bottom right. 
The spacebar is always in the middle of things, operated by your thumbs. 
What can you do quickly with the keyboard? Well, right now, you can clear all of 
the stuff on your screen, safely minimizing it to the bottom of your screen where 
your Task bar lives (next to the Start button) by holding down the Windows logo 
key and pressing the letter 'D'. 
The Logo key is on the bottom row... between the Ctrl and Alt keys to the left of 
the spacebar and to its right. 
Try it. Hold down the logo key... press 'D'... and release 'D'... then release the logo 
key. 
If you press the Logo key alone, nothing happens until you release the key. Press 
and release it to activate the ... well try it and see! 
Want to copy some text from a web site and paste it into a word processor such 
as Word or Wordpad? Open the word processor... and open the web page... high-
light the text with the mouse cursor... then hold down the Ctrl key and press the 
'C' key. You won't see anything happen. Now, move to the word processor, click 
once where you want the next to appear to set the cursor. Then, hold down the 
Ctrl key, and press the 'V' key. 
The text will appear. If it doesn't, you didn't highlight the text from the previous 
document (in this case the 'document' is the web page you are copying from.)  
You can highlight text with the keyboard, too. Right now, make sure your cursor is 
located in the body of this email. Doesn't matter where, this is only an illustration.  
Now, hold down the Shift key... and press the right arrow key repeatedly. Hmm... 
magic! See the text being highlighted? It's being 'selected'! 
Select as much as you desire, then do the Ctrl + C thing to copy, and Ctrl + V to 
paste. (Ctrl + C is shorthand for saying "hold down the Ctrl key while you press 
the C key.") 
One last 'trick' ( for Win 98 users only): Want to quickly view the System Proper-
ties of your computer? That is, see how much RAM you have, the amount of re-
sources free, and more? Just press and hold the Windows Logo key while you 
press the Pause/Break key. The System Properties window should appear. 

Browse to find the folder  you saved your mail into, click OK, then Next. Click All  
Folders > Next and then Finish.  
To import your Address Book, go to the File menu, click Import > Other Address 
Book, click Text File (Comma Separated Values) and then click Import. 
 Browse to your back-up folder, click  the Address Book back-up file and click 
Open. Click Next >  Finish > OK, then Close.  
For Mail and Newsgroup accounts, go  to Tools > Accounts > Mail or News 
(depending on which you’re  importing) > Import. Click the account you want to 
import,  then Open.  
Thunderbird  
Thunderbird, which is steadily rising in popularity, is even  easier to back up and 
restore. Exit all Mozilla programs, and  browse to the folder containing your 
Thunderbird profile data. You can generally find this at C:\ Documents and 
Settings \ [User Name] \ Application Data \ Thunderbird.  
For Windows  95/98/Me, you may find the folder here: C:\ WINDOWS \  
Application Data \ Mozilla \ Thunderbird.  
Then, copy the  Thunderbird folder to your back-up location. It’s that simple. To 
restore your emails, ensure that you close all Mozilla applications.  
Then, just copy the backed-up folder to the same  location that you originally 
found it in, ensuring that it’s  got its original name, too. If you’re moving the 
folder to a  different location, perhaps because you’ve changed drives or  PC, 
visit http://kb.mozillazine.org/Moving_your_profile_folder  for more information.   
Helen French   

(Continued from page 11) 

Back up Outlook Express emails 
Head to the Tools menu and click Options. Go to the Maintenance tab and click Store Folder. Then select 
and copy the folder location ([Ctrl] + [C]). Close the dialog. Click Start > Run. In the Open box, press [Ctrl] 
+ [V] to paste the location, then click OK.  
Once it’s opened the folder, click Edit > Select All. Click Edit again, Copy and then close the window. 
Create a new folder wherever you want your backup to be saved and press Edit > Paste (or simply click 
[Ctrl] + [V] in the folder). Perform all of these steps for each Outlook Express identity.  
Use XP’s File and Settings Transfer Wizard 
If you have XP you can use the File and Settings Transfer Wizard to back up your email. Start the wizard, 
choose Old Computer and click Next. When asked to select a transfer method, choose Other and enter 
an appropriate destination. 
Click Next. Choose ‘Let me select a custom list of files and settings’ and click Next. Remove everything 
on the list except for Outlook  Express and finish the wizard. It won’t save passwords so keep a record of 
these.  
If you need to restore, just start the File and Settings Transfer wizard again, choose the new computer 
option and point the wizard to the backup data you saved in the steps above.  
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Tutorial... "Understanding Disks" 
================================ 
One of the commonest things that PC beginners get mixed up on is the lowly disk 
or diskette. This section should reveal a few things you need to know about these 
vital parts. 
There are only two classes of disk-- the magnetic type, and the optical type. What 
follows will help clarify this point. 
CD-ROM disks are perfect examples of optical disks. The data that is "read" from 
them is obtained by a laser beam. If you ever look closely at the inside of a CD 
player, you'll notice a little label that warns about the laser. CD-ROMs hold at 
least 650 megabyte's worth of data. That's about 650 million characters, roughly 
speaking. 
Of course DVDs and Memory Sticks are now extremely popular - but let's walk 
before we run:-) 
Magnetic Disks are the standard-issue 3-1/2 inch units you can buy in packs of, 
well, almost any number. They have a little metal shutter that protects the inside 
disk, which really is floppy. 
Now, no floppy disk in the world will hold the contents of your next backup. They 
hold just over 1 megabyte of data--that's 1.44 megs, to be exact. And part of that 
space is taken up with a little directory information, so you'll really only have 
about 1.38 megs available for actual file storage. 
Floppies are good for storing articles, reports, and other items that are relatively 
small in size. Remember the one megabyte limit. Some small games will fit on a 
floppy, or multiple floppies, and they're also very portable. 
You can back up your entire 10 gigabyte hard drive on floppies, but you'll have to 
obtain a very large number of diskettes to accomplish this. How many? 
Think of it this way. There are 1,000 megabytes in a gigabyte. So, 1,000 times 
10 is the number of floppy disks you'd need if you were to attempt such a silly 
feat. Of course I haven't figured in the ".44" megabytes of additional space on 
each disk, but you still get the picture. After all, this is *supposed* to be easy to 
understand.... Yeah right! 
There was a time when diskettes were the primary method of distributing soft-
ware. Then came the CD-ROM, and the diskette became nearly obsolete. 
Diskettes have grown less useful because programmers have gotten lazier. It 
takes a lot more work to program in machine language, instead of visual lan-
guages, which results in programs that are simply huge. 
But, as computers have gotten faster, and storage space cheaper and bigger, the 
prevailing attitude is one of "why minimize when the consumer has so much stor-

age space available?" 
Optical disks store a tremendous amount of data. But they require special hard-
ware called a CD Writer. It's a lot like a CD player, except you can actually create 
your own CDs--both data and music. There is a difference! 
A data CD won't do anything in your stereo CD player. But your music CD will 
work just fine in your computer's CD player. And of course, these can be internal 
or external devices. 
CD writers can also play your CDs. They're a dual purpose machine, and they 
usually work extremely well. 
If you want flexibility, consider installing a second CD writer along with your CD 
player. That way, you can copy direct from one CD to another. 
For you old timers who grew up with DOS, the old 5.25 inch floppy disk is proba-
bly still in your memory. The old disks will still work with a new computer, if you 
can find a 5.25 inch drive. You can run whatever's on them in DOS mode, or 
from the DOS Prompt, accessible from the Start Menu. 
The old 5.25 inch floppy disks (hey, they were truly floppy!) were also suscepti-
ble to corruption, since there is no protective shield over their delicate magnetic 
surface. Just a window that exposed the insides to the world. I always cracked 
up when I read the dire warning, "Don't touch." That is, don't touch the magnetic 
surface. It made sense. How many floppies died untimely deaths? More than 
you can count. 
Since floppies don't hold much, along came a company named Iomega and de-
veloped what became the most popular format on the market-- the Zip drive and 
its associated Zip disk. These little guys hold 100 megabytes, and now there's a 
250 megabyte version. Other companies have similar products, but they aren't 
as popular. I have to hand it to Iomega for a fine marketing effort and market 
saturation. 
Iomega makes larger capacity removable disks, known as the Jaz and Ditto, as 
well as many other slick drives. See the web site for more information about 
these products: 
www.iomega.com 
Now of course we have external hard drives that hold 300 GIGABYTE and more. 
Boy how quickly technology changes:-) 
When is a disk not a disk? When it's a tape. Tape drives use (of all things) tape 
to store data. Magnetic tape, to be sure. A lot like the familiar cassette tapes 
that are becoming less popular every day, these units can store massive quanti-
ties of data, and are measured in gigabytes of storage. 

(Continued on page 14) 
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Don't confuse storage capacity with memory. Memory is dynamic--it only works 
when the power switch is on. Storage is static--it depends on a magnetic field 
that is set by the part of the hardware that does the work--the part known as the 
data head, or read/write head. It's a mechanical arm that you can think of like 
the arm on an old record player. 
Did I say this was easy? 
Just imagine the old record player's stylus writing lines of data onto the surface 
of the vinyl disk, and you've got a pretty good mental image of the way things 
work. 
CDs don't require anything approaching magnetics, but they too use an arm de-
vice that moves back and forth, writing or reading data via a laser beam. So the 
record player analogy holds here, too. 
Ever seen a big jukebox that plays CDs? The kind where you can watch the CD 
actually being pulled into close association with the play head, and then watch it 
spin? There's your CD player's insides magnified for your viewing pleasure. 
New storage devices are always in the works. As learning increases, technology 
leaps forward. Things get smaller, faster, and cheaper. But remember, if you 
wait long enough to buy some new techie item, awaiting a price drop, you won't 
have to buy it all. It will probably become obsolete! 
Isn't technology just absolutely wunnerful? 
Hmmmm ... 

(Continued from page 13) A Blast From The Past 
TECH TROUBLES 

The following stories are from the TechRoom Web site thanks to 
Bill Donald. who emailed this to me. 
Colon Trouble  
Thanks to: Gunner  
I do tech support for a major computer company's big accounts division. Most of the calls 
I take are from system admins and other well versed computer users. Though, on 
occasion, I'll get the temp secretary in the office. Still, usually knowledgable enough use 
the system. This guy just took the cake one day...  
Tech: Thanks for calling (XXX). How can I help you?  
User: My company headquarters just sent me this disk with quotes on it for my 
spreadsheets and gave directions to access them, but they aren't there.  
Tech: Okay, what where the directions?  
User: Put in the disk, double click My Computer, double click 3 1/2 Floppy and they 
should be right there.  
Tech: And you don't see anything there, right?  
User: Right.  
Tech: Okay. Click on Start, then Programs, then MS-DOS Prompt and that should take you 
to a DOS prompt.  
User: Okay, I'm there.  
Tech: All right. Now, type A: and hit Enter. (pause...)  
Tech: Are you there?  
User: Which one is the colon? The two dots or the dot and squiggly line? (Not done yet...)  
Tech: The two dots.  
User: Okay. (we did a DIR and found files on there. Got back into Win95 and followed his 
instructions again)  
Tech: Okay, now looking at the floppy there, you don't see anything?  
User: Nope.  
Tech: Do you see a scroll bar there?  
User: A scroll bar? After ten minutes of explaining what a scroll bar is and how to use it, 
we finally found his missing files. I wonder sometimes if I shouldn't get the number to 
these companies' employment office and apply. 

A Million Netscapes!  
Thanks to: Anonymous Tech Supporter 
I thought this was a cute call I received for tech support from a nice lady:  
me: thanks for calling tech support.  
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customer: I have a problem! I open up netscape and it tells me I don't have enough 
memory. me: Okay, no problem, do you have any other programs running?  
customer: Well, not that I know of. only Netscape.  
me: (thinking: of course, they usually can't tell) On the bottom of the screen, do you see 
any boxes that have names in them? (gotta be simple!)  
customer: oh yes, I have about thirty boxes that have "N's" in them. me: You mean 
Netscape? you have a tons of boxes that say Netscape? customer: Oh no, they just have 
N's. me: (thinking something could be wrong with Netscape) Okay, ma'am why don't you 
restart your computer. customer: (??) How do I do that? me: click on the start button, 
click on shutdown, click on restart the computer and click on ok or yes. customer: 
(pauses while she clicks and clicks) okay, it's restarting. what do you think could be the 
problem? me: could be a number of problems ma'am, when it restarts, everything should 
be just fine. customer: okay, that's good, I wasn't sure what ... (pauses, while I hear a 
numerous amount of beeps in the background.) Oh my gosh! (panicked) the computers 
beeping at me! me: (laughing while the mute button is on) Okay, maam, is your enter key 
stuck? customer: enter key? well, it looks like it's wedged in, yes, so i guess it's stuck. 
me: go ahead and fix that, the computer should be okay now. (laughing) customer: oh, 
could that have been the problem?? me: oh yes, I'm sure it was. It was a good laugh, she 
was so sweet too.  
 

Senior Network Analyst  
by Anonymous Tech Supporter  
This really happened to me about 3 years ago when I was working a telephone tech 
support job for an online service. AT&T was beta testing a program called "Interchange". 
The beta product "sometimes" required a bit of "ini" editing. I was guiding an older 
gentleman through the process of editing an "ini" file with notepad and when we were 
finished I told him to: 
1. Save the ini file  
2. Close all windows  
3. and reboot the computer  
Honest to God I heard the man put down the telephone and he started closing the 
windows in the room that he was sitting in. I never forgot that.  
 
Working on a phone support help desk is many times the way you describe it, Laugh -
Scream - Cry and Pulling your hair (this will help you avoid putting your fist through the 
telephone) 
 

Yours or Mine?  
Thanks to: Anonymous Tech Supporter  
We're an ISP and I was setting up a customer to get connected to the net. tech "OK we 

(Continued from page 14) want to set up you're connection. Double click on "My Computer" customer "How can I 
click on your computer?" 
 

Where is the Explorer? 
Thanks to: Karen 
We work for a payroll software company in the tech support department. One of the techs 
was on a rather long call with a user late at night. While trying to troubleshoot a problem 
she asked the user to get out of our software and go to her Explorer. The user was not 
happy with this request. She said that it was raining outside and her "Explorer" was at the 
other end of the parking lot. 
 

Wrong Size CDROM  
Thanks to: Rich S  
I do tech support for an ISP, One day a woman calls trying to tell me that we sent her the 
wrong sized installation cd, the call proceeded as such.....  
Me: hello tech support, how can I help you?  
Customer: Yes I just received your cd in the mail, and it isn't the correct size for my 
computer, Can you send me a smaller one?  
Me: do you mean you need the floppy disks instead of the cd?  
Customer: No, I need the round cd but the one you sent me doesn't fit all the way in the 
drive, it only gos about half way in and then gets stuck.  
Me:You mean the tray doesn't go all the way back in?  
Customer: Tray?..there is no tray I just stuck it in the big slot on the front of my computer!  
Me: (at this point I realised what was going on, she didn't have a cd ROM drive at all, she 
was trying to force the cd into a 5.25" floppy drive.) 
 

The Zip Drive That Just Wouldn't Go  
Thanks to: Jonathan Lotman 
I was working the evening shift when the call came through on the Dial -A-Tech line. The 
guy was attempting to install a Zip drive on a new computer, and no matter what he did, 
the computer would not read any disk put in the drive, despite the fact that the 
Removable Drive was showing up under My Computer.  
 
So I had him run the install program off the disk. It found the drive and assigned it a 
letter, but he still couldn't read a disk off the drive. Then I had him check his BIOS to 
verify that his printer port was set to EPP mode. No change. So I had him run a manual 
install of the drivers through the Add New Hardware icon. Doing this brought up a fatal 
device conflict.  

(Continued on page 16) 



Page 16  

Then I asked the guy "What model of computer do you have?"  
The guy replied (with no small amount of pride), "It's a Compaq 4550, I ought to know, I 
picked it out myself."  
To which I replied, "Sir, open the front panel on the computer." A click. Silence.  
Then I hear over the phone,"*@(&#! There's a Zip drive already in this thing!"  
At that point, I hung up on the guy and went home for the night. 
 

But I'm in New York!!  
Thanks to: Steve Straus 
I am a technical support representative for a large online service. One day I got a call 
from a lady who had NEVER turned on her computer. This is how the conversation went:  
Me: Thank you for calling *** My name is Steve, what can I help you with tonight.  
Lady: I'm trying to get online with you guys and I can't figure it out!!  
Me: Okay, where do we start??  
Lady: how do i turn it on?  
Me: hit the button that says power or I/O (this took around 10 minutes because I had to 
explain the difference between hitting the power button on the monitor and the one on 
the CPU box...) Lady: Okay, what now?  
Me: Do you have our software installed?  
Lady: What's software?  
Me: do you have one of our floppy disks??  
Lady: I have a hard disk??  
Me: ::sigh:: okay....go ahead and put it in the drive, and click on file then run  
Lady: ..................(almost crying) I don't see "file"  
Me: okay, I want you to double-click on your "main" group  
Lady: "Maine?" I live in New York!  
Me: (containing laughter)I'll...be...right...back... (At this point I had to put her on hold for 
about 3 minutes to collect myself, I was DYING of laughter, as was the new guy who was 
paralleling with me at the time, it was the first call he had ever heard and we both almost 
threw up from laughing so hard. She hung up before I could get back to her.....) 
 

A Real WIN-near  
Thanks to: Hodge 
This story takes place about 6 months ago. I work at a convenience store that has a POS 
(point-of-sale) system installed on the office computer. This helps us with bookwork, and 
inventory. (by the way, this tale is about a tech - not a customer) The original POS 
program was starting to fail repeatedly, and was in need of upgrading. We contacted the 
company we got the original software from, and made arrangements for the delivery and 

installation of the upgraded version which even at this point in time was still a DOS 
program. I happened to be in the store on one of the two days the tech was there. She was 
diligently working away in the office, and the boss and I were standing near a display 
discussing business. The tech came wandering out and seeing us, trotted over and asked 
us this:  
"How do I get into Windows from DOS?" (The computer has Win31.11 on it.)  
My boss and I looked at each other, then turned to the tech and we both said, 
"W - I - N, then hit 'enter'" I still can't believe that, y' know? 
 

The Price of a Printer Port  
Thanks to: Abd Wahab 
I don't know if you ever heard of this, but it really happened to my colleague this morning. 
My friend attended a call that goes something like this....  
"Hello, is this IS Technical Support? I have a problem with my printing because the 
message here says that I need to have the printer attached to this printer port. If you have 
a spare one, could you sent it over? I really need it fast because my boss wants me to print 
a few documents urgently. Could you help me on this? Anyway, how much does it cost if I 
have to buy it?" 
 

The Sloppy Floppy  
Thanks to: Dermot O' Hagan 
My tale begins back in the 386 era. I was working for a small computer sales and service 
centre in Dublin (yes, Ireland) that, to help "make the sale" regularly sold 4 hour on-site 
warranty for a pittance just to get the business. Needless to say, the tech support 
department (one guy) was very busy and always tried to fix problems over the phone. Here 
is one support call that he related to me that I have repeated and chuckled over many 
times.  
Cust: The floppy drive on this new computer that you sold me doesn't work.  
Tech: Have you tried a different diskette?  
Cust: I have tried over twenty, it doesn't read any of them.  
The support department then walked him through trying another diskette, confirming that 
the power light lit on the drive but it wouldn't read or format the disk. So he went out on-
site. When he got there, he put his diag disk in the drive and checked it out thoroughly. 
Everything was fine. So he asked the customer to show him how he used it and when the 
problem occurred. The customer then produced a pile of black diskettes and put one in 
the drive producing the required error. Holding back tears of laughter, the technician 
explained to the customer that cutting the edges off his old 5.25 inch diskettes and 
sealing them with electrical tape does not make then compatible with the (then) new 3.5 
inch drive. 

This article was first published in “Reset” August 1998 


